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Justin Heckroth, and Michael
Fischer from the Davenport Staples
brought a wide range of tablets and
Windows 8 computers for us to
feast our eyes upon. Computer innovation moves relentlessly along
and this year has not been different.
The biggest impression from their
talk is that computers now are
touch screen thin devices that we
can carry with us where ever we go.
The mantra of the Smartphones has
moved computing everywhere.
There has been much discussion
about the Windows 8 platform since
its release earlier this year. For
Windows XP and Windows 7 users,
yes the visual shock is there. The
icons are big, square, moved by
touch and swipe. But after seeing
Justin and Michael move among the
various devices, the logic and ease
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of working with the new arrangement makes sense. They handed out
several of the laptop computers and
tablets for us to share around the
group. You could tell by the interest
and discussion in the audience that
these new devices held our attention and fascination.

at the Butterworth Education center.
He said that the battery life for this
tablet was long.
Next on the docket for display
was the Kindle Fire HD 8.9. This is
the new and largest Fire tablet from
Amazon. The processor was upgraded to a dual core. It has a front
facing camera, lots of android applications available and is an useful
book reader as are all Amazon
devices.
He segued to the several Windows 8 devices on the table display.
First up was the 23” Samsung all-

Justin began by demonstrating the
Views and opinions expressed
recently released Nexus 7 tablet by by presenters do not necessarily
Samsung. It is a Google centered
reflect those of the
Quad-Cities
Computer Society.
device, and is android based. A
Monthly
meetings
are open
touch screen interface with many
to the general public.
apps available. A front facing camera allows you to video Skype with
your friends and relatives. The Nexus 7 connects to the Internet
through wi-fi. Even tough it is a
tablet, Justin mentioned that there is

The QCS is a member of

1

Additionally Justin noted an icon
on the left the of main Windows 8
screen which brings forth the regular style Windows 7 desktop also.
He also said that the mail icon
brings up your mail interface with
one touch of the screen. Below the
mail icon is an area that displays
your computer photos. By touching
that icon your pictures are shown in
pattylowry@rocketmail.com
full screen mode and are moved
QBITS
along by swiping your finger left or
Published monthly by the
right on the screen. You can also
Quad Cities Computer Society
c/o Dave Tanner
pinch zoom your photos as well.
photo by Vicki Wassenhove
3449 - 52nd St
With Windows 8 you don't have
Moline, IL 61265
to concern yourself with steps to
webpage: www.qcs.org
Since we could see everything on
share your photos, it is done autoCo-editors
this large screen he proceeded to
matically to Facebook, Skydrive
Joe Durham
guide through the Windows 8 touch
joseph85_us@yahoo.com
and email.
screen swipe experience. Everyone
Patty Lowry
If you purchase two monitors, the
pattylowry@rocketmail.com
wondered? Where was the Start
Windows 8 dual screen interface is
button?
quite useful in his opinion. On one
The Quad-Cities Computer Society
is the standard Windows 7 style
or QCS is an Iowa nonprofit
organization for charitable, scientific,
desktop and on the next monitor is
and educational purposes primarily to
the collection of Windows 8 icons
educate the public concerning the
and programs. You can move
advantages and disadvantages of
Justin explained that the Winamong these simultaneously. On the
microcomputers and to publish a
dows 8 start function is accessed
left hand side of this All-in-one
newsletter for distribution to members,
through the charm bar. This bar aparea libraries and educational
device are USB ports.
institutions. The QCS is recognized as pears as you swipe and touch the
As one surveys the entire collecfar right hand side of the screen. In
a 501(c)(3) nonprofit charitable and
tion of tablets and Windows 8 comeducational organization by the IRS.
the middle of a vertical set of icons
puter one is struck by the fact that
Copyright QBITS copyright © 2013 by is a blue windows icon. Touch this
there is no DVD roms or mice
the QCS. All rights reserved.
and it returns you the main screen.
Subscriptions are included in cost of
present. An audience member asked
Michael also demonstrated that
membership. Reproduction of any
how do you install your previous
material herein is expressly prohibited you shut down the computer by
programs. Justin said that you can
unless prior written permissions is
touching the settings icon in this
purchase a usb CD rom or DVD
given by the QCS. Permission to
charm bar, which reveals the norrom as the means of installing your
reprint material contained herein is
mal options of shutdown.
granted to other non-profit personal
software. Also many software titles
computer groups provided the full
can be downloaded and installed
attribution of the author, publication
online now.
title and date are given, except that
One of the laptop computers did
articles with Copyright notice in the
not have Windows 8 on it, but inheader indicates article may be
reproduced with the express written
stead had Windows RT. This compermission of the author ( or other
puter has all the look and feel of
indicated copyright holder). Brand or
Windows 8 device but you can't use
product names are trademarks of their
Windows 8, 7 or previous software
respective carriers. As a typographic
on it. This computer has a different
convention we do not so identify as
such.
processor and required a unique
Would You Like to receive
your QBITS via email?
The QBITS can now be produced
in Acrobat PDF format and sent to
your email box. If you desire to
have the newsletter sent to you
electronically instead of by US
Mail, notify:
Patty Lowry,
QBITS co-editor
(563) 332-8679
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in-one monitor. This is a Windows
8 computer, monitor, hard drive in
on unit and is touch screen.

QBITS January 2013

coding to operate.
For this Windows RT computer
you need to purchase and access
free programs from the Windows
App Store with titles written for the
Windows RT platform.
The remaining laptop devices ran
Windows 8 and each had their own
allure and use. Computer manufacturers have designed laptops to
make use of the touch screen experience in new ways.

One of the interesting concepts
was the Lenovo Convertible laptop
with Windows 8. The screen swivels so that you use it as a regular
laptop, and then twisted around it
turns into a tablet because of the
touch screen feature.

be exchanged by the manufacturer
due to their design.
Justin and Michael dangled before our holiday eyes the entire
gamut of current computing: on the
low priced end useful tablets: the
Nexus 7 and the Kindle Fire HD
8.9. To the middle line of Samsung,
Asus, Lenovo Windows 8 laptops
with different operating configurations. To the high end Samsung Allin-One computer which would act
as a one stop center for the entire
galaxy of gadgets you have in the
house.

There is More to
Skydrive than you
remember

Need More Space?
Skydrive gives you 7 GB of free
storage to securely access over
7,000 photos or 20,000 documents.
Organizing just got easier
With the desktop version of SkyDrive—on both PC and Mac—you
can upload larger files, easily organize them, and instantly synchronize your files across all your
devices. goo.gl/HuDLy

Use familiar tools in Office
Web Apps
Enjoy free Word, Excel, PowerMichael Fischer / Justin Heckroth
Point, and OneNote web apps built
photo by Vicki Wassenhove
into SkyDrive. Create, edit, and
share your files from almost anyThe QCS would like to thank Justin
where. goo.gl/5ZXOz
and Michael for their tantalizing
There was an Asus Windows 8
foray into Windows 8 and tablet
More devices for you to
laptop that has a detachable screen,
computing. If you have any
choose from
which turn the machine into a tabquestion send them an email at
Access your files with consistent
let. Click the screen back into the
cc0444@staplescopycenter.com
formatting on all your favorite
keyboard dock and it turns back
or call their Davenport Store at
devices including Windows Phone,
into a laptop computer. Justin poin563-359-4600 or visit their store in
Android, and iOS. goo.gl/Gtl2h
ted out that the detachable keyboard
person to examine again the tablet
had the standard usb port through
or windows 8 laptops that meet
P. S. Did you know about the
which you can attach all of your
your needs
apps?
devices to the laptop.
____________________________
Find out about the latest apps that
The battery life of these new
work with Skydrive goo.gl/n9jT4
laptop computers is robust, around
4 – 5 hours of a normal use. They
said that they would probably last a
couple of years and would have to
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Flash Memory
Survival
by William Tracy
Just how tough is an HP 1GB
Flash Memory Drive? In Glendale,
a unit has been tested. In August
2010, Bill Tracy left an HP in his
Dockers when he washed his
clothes. Could the HP survive this
kind of abuse?
The HP was in his front-right
pocket when it endured the mishandling. The Speed Queen commercial washer was set in Normal
Permanent Press so dockers were
washed in hot water at 110 Degree
F. using 1 cup of Tide Detergent
powder. Following the wash and
rinse cycles, the trousers also went
through a full high-speed spin cycle
to wring out the wetness. Then the
Dockers were thrown into a Speed
Queen Commercial dryer where it
collided with steel surfaces. At
some point the HP escaped the
Docker pocket and endured harsh
crashes inside the Dryer. Afterwards, the HP End Cap was still attached.
When the Dryer stopped, all the
clothing was removed but the defiant HP stood up leaning against the
wall like John Wayne after a gun
fight. The solitary figure was immediately identified and removed from
the Dryer. But there was serious
doubt about any memory left in the
unit. However, when plugged into a
Dell computer USB port, all the recorded data was still there. Nothing
was missing. It had survived.
So now we know. HP Flash
Memory Drives are indeed tough!
Can any of the other manufacturers
make that boast?
From TUGNET,
the Users Group Network, La Crescenta, CA.
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VIPRE
by Susan Kennedy
TUGNET, CA
(reprinted from the October 2012 issue
of the Monitor the newsletter of The
Rochester Computer Club)

What, you ask, is VIPRE? The
name is an acronym for Virus Intrusion Protection and Remediation
Engine. More simply, VIPRE by
GFI Software Inc. (formerly Sunbelt WSoftware) is a product line
that includes both a stand-alone antivirus program and a more comprehensive internet security suite.
Dodi Glenn, Product Manager for
GFI, started by asking us What is
malware? What dangers are out
there? Malware includes adware,
bots, dialer programs, keyloggers,
rogue anti-virus programs, rootkits,
and spyware along with the usual
viruses, worms, and Trojans. He described malware as having gone
wild with a huge increase in recent
years. The purpose is no longer to
damage peoples computers; the
motive today is almost 100% financial. Cyber criminals want access to
your computer, your passwords and
account information, and thus to
your money! Besides stealing from
your accounts directly, crooks make
fortunes in selling credit card information. Much of this criminal
activity originates in Russia and
China.
Top threats include various forms
of Java script. Some of the threats
he named are the System Restore
Rogue and S.M.A.R.T. Repair that
may harm your hard disk drive.
A few threats created by governments have escaped into the world
at large. We probably all know of
the Stuxnet virus, believed to have
been created to wreak havoc with

Irans nuclear program, but coming
along today is Duqu, first spotted in
September 2011. Another is Flame,
a program developed by the CIA,
NSA, and Israeli military, to attack
nukes in the Middle East. For those
of you who are fluent in high-level
geek-speak, GFI produced a video
(33 minutes) on their analysis of
Flame at vimeo.com/44382073; its
pretty heavy on the technical stuff.
Another type of threat involves
social engineering, and many of
these come out of India. One example spoofs Microsofts tech support center, where a person calls on
the telephone to tell you of a problem with your computer that he can
fix if you just allow him remote access. The Better Business Bureau
published an article you can read at
tinyurl .com/7noulky. You can also
see videos on this threat on YouTube by searching for Microsoft
Service Support Center.
Where does this malware come
from? Today its mostly social networking (e.g., Facebook), online
games, and email or through portals
you access either for games or chatting in forums. Malware (including
spam) gets into your email through
hacked web sites you visit, instant
messages (such as posting on Facebook), and what are known as exploits in valid programs such as
PDF, Java script, and Flash Player.
One threat few recognize is the
lost flash drive. If you find a flash
drive dropped in a parking lot or lying on a library table, for example,
the natural instinct is to plug it in to
a) see if the owners name is available or b) just to see what might be
on it. Dont do it! That drive may
have been left intentionally because
it was deliberately infected with
malware (such as a keylogger or remote dialer) that will infect your
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computer when you try to access
the info.
Dodi then described the steps one
should take if your computer becomes infected or you suspect it
may be.
< Be sure you have a good up-todate antivirus program on all machines before you access the internet.
< Scan all your machines if you
are on a network.
< If you discover a worm or virus
on one machine, unplug it from
your network.
< Get VIPRE Rescue from
live.sunbeltsoftware.com or live
.vipreantivirus.com; then restart
your machine in Safe Mode and run
the Rescue program. When the report displays, any entries in red are
serious threats that must be removed. Some other good anti-malware programs that Dodi recommends (many free) are Malware
Bytes (www.malwarebytes.org)
< Super Anti-Spyware
(www.superantispyware.com)
< TDSS Killer |
(www.super.kaspersky.com/)
< ComboFix
(www.bleepingcomputer.com/
download/anti-virus /combofix)
and
< HijackThis (from any of several
sites such as
www.majorgeeks.com or
www.filehippo.com.) How can you
prevent these threats from getting to
your computer?
< Keep Adobe Flash Player and
Java updated.
< Disable Java scripts from running in Adobe. < Disable the function that lets your browser open
PDF files automatically.
< Keep your operating system
patched and updated.
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< Use a reliable anti-virus program or internet security suite.
Some other tips Dodi offered include:
< Don't click links that you find
in emails or on web sites; or at least
do so with great caution.
< Be very wary of attachments to
emails, even from people you
know. The bad guys may have
spoofed your friends email address
and sent you malware.
< Use a site advisor such as Web
of Trust or MacAfees Site Advisor.
These program add-ons check web
sites to see if they are safe and secure for you to visit. Web of Trust
(WOT) (www.mywot.com) is one
that works in all browsers. It is
community driven; that is, it is run
by its users. When you are checking
a web site, a red circle means the
web site is infected.
< Watch your mobile devices
(tablets, smart phones, ebook readers) as carefully as your main computer. Lookout and VIPRE Mobile
for Android are free programs for
this. VIPRE Android also backs up
your contacts and has a locater
should you misplace your phone.
(Kindle readers run on Android, but
VIPRE Mobile is currently restricted by Amazon.)
A new threat is those ubiquitous
QR codes that are popping up
everywhere. The Norton security
program warns of bad QR codes.
Following these tips will not protect you 100% nothing can, but they
will go a long way to keep your internet experience safe.
Presented at the Southwest Technology & Computer Conference, San
Diego, by Dodi Glenn, VIPRE Product
Manager, GFI Software (with Kathy
Wattman, Product Marketing
Manager). Courtesy of APCUG. The
Rochester Computer Society, Inc.
Monitor / October 2012

Notes from the
Beginner's SIG
presented by Jim Kristan
by Joe Durham
Jim always has very good informational tips for computer users. The
December meeting of the Beginner's SIG was no different. He discussed the Snipping Tool and making an image of your computer for
safe keeping.
Snipping Tool

Go to Start Button → Accessories→Snipping Tool. If you use this
tool often Jim suggests that you
drag this to your desktop with the
right mouse button and select create
a desktop icon, then a Snipping tool
icon will remain for handy reference.
Once the tool is activated, your
entire screen becomes shaded in
white, us the cursor to drag around
the area of the screen you wish to
snip. After it is selected you can
save it to your computer or even
email it to someone directly.
Making an Image of your
computer
We all know that computers will
fail, or get infected so it is wise to
plan ahead from the very start when
you get a computer.
Computers don't come with install disks now. Sometimes there is
a special partition from which you
can restore your computer, but that
is cumbersome and requires technical help. It is better in Jim's view
to make an image of your computer
--continued on next page--
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just after you get it to a set of
DVD's or to an external hard drive.
He noted that external hard drive
prices are becoming very reasonable so it is a wise investment. They
are usually usb devices, easy to
connect to your computer and recognized by the Windows operating
system.

document, you can use a text box to
repeat the statement in a "pull
quote" and locate it in an unexpected spot, such as along a margin
(known as a Sidebar) or across
columns in the document. Its flexibility makes a text box useful in
many situations.
Text boxes have most of the same
properties as shapes. In Word 2007
and 2010, when you click the Insert
tab, then Text Box, you open the
Text Box gallery of 36 preformatted
text boxes, as well as the "Draw
text box" option. If one of the preset boxes meets your needs, click to
insert it into the document. Older
versions of Word lack this gallery,
but you can still draw a text box,
which is most often my choice.
Click "Draw text box" at the bottom
of the gallery. Then click anywhere
in your document where you want
Go to Control Panel → Backup &
the text box to appear and drag diRestore → Create a System Image. Get Creative with
agonally down the page to the right
Windows will ask you where you
Text Boxes
to create the text box. At first the
wish to place your image on DVD
box covers a portion of the normal
by Nancy DeMarte
or a hard drive.
(reprinted from the December 2012 is- text. This is because the default text
sue of DACS.doc the newsletter of the wrapping setting is "in front of
Danbury Area Computer Society)
text." If you don't want the text box
to hide the document text, select the
W HEN YOU USE Microsoft Oftext box so "handles" appear around
fice, you create and edit text all the
the box. At this point, the Text Box
time. Word, of course, is dominated
Tools Format tab appears on the
by text; Excel and PowerPoint both
ribbon. Click Format, and then Text
use text in many of their functions.
Wrapping in the Arrange group.
If you select DVD it will prompt All recent versions of Office also
Change the setting to Tight, which
you to place DVD's into your mainclude a tool called a "text box"
will position the text box within the
chine as you go along.Write backup for special uses of text. Let's find
existing text and also allow you to
numbers on the DVD's with a felt
out what it is and how to use it. A
move the text box. Do this by clicktip pen, not a pencil or a pen.
text box is a specialized shape in
ing an edge so a crossed arrows
which you can enter text. It funcicon appears and dragging it to a
If you select Hard drive it will let tions outside the regular margin
new location. You can also resize
the available ones be seen by your
constraints of a document and can
the box by dragging an edge or
computer. In this case you have pre- be moved or resized as needed. A
viously attached your external hard text box is useful for adding a cap- corner. To enter text in the box, replace the informational text with
drive, it has been recognized by
tion to a photo or annotating a diayour own.
Windows and thus will show up in gram or chart. If you want to emOnce a text box is created and
this list.
phasize an important statement in a
located in the document, it can be
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A large image size may take some
time to finish Jim mentioned, so be
prepared to get a cup of coffee or
do something else. When it is complete he recommended that you
safely remove the hard drive by
clicking the icon on the taskbar and
click safely remove drive. Don't remove it until the computer tell you
to do so. Then put that hard drive in
another separate location for safekeeping.
Both of these examples are useful
tips for all computer users. If you
think you would like some tips on
using your computer more
effectively, or have some questions
how to use or do something, drop
by the Beginner's SIG, it meets
before the General Meeting each
month at 5:30.
____________________________
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formatted in many ways. To format
the text, select it, and a small version of the Font group on the Home
tab will appear. Use these tools to
change the font style, size, color,
and other attributes. (You can also
click the Home tab and use the full
set of options in the Font group.) To
format the text box itself, select it
and use the tools on the Text Box
Tools Format tab. For example, you
can fill the box with a color, remove or change the border styles,
make the text read vertically, or add
special 3-D effects.
In Office 2007 and 2010, text
boxes are not limited to a rectangular shape. You can add text to any
of the items in the shapes gallery.
Click Insert - Shapes and click a
shape. Click in your document and
draw the shape in the same way you
drew the text box. Change the text
wrapping to Tight as you did above,
then right click inside the shape and
choose "Add Text". The large number of shape choices gives you
many options for text boxes. Another approach is to begin with a classic text box, even after it is filled
with text. Select it, which opens the
Text Box Tools Format tab. Click
Format and select "Change shape,"
which opens the shapes gallery.
Click a new shape, and the text box
transforms into that shape with all
its contents intact. Another interesting possibility is inserting a photo
or piece of clip art into a text box.
With the text box or shape selected,
click the Insert tab - Picture. Click
the photo you want, then Insert. The
photo appears in the text box, resized to fit. The same steps work to
insert clip art, charts or tables within text boxes.
Text boxes can be rotated for a
dramatic effect. In Office 2010, select the text box, and click and drag
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the little green rotator circle above
the box to rotate it left or right. In
Word 2007, for an unknown reason,
classic text boxes cannot be rotated,
even though shapes can. One way
to work around this problem is to
create a text box, cut it using the
Cut command on the Home tab, and
then paste it as a "Picture (Windows
Metafile)" using the Paste Special
command option under the Paste
icon.
Occasionally, you might create a
text box in Word that you'd like to
reuse at a later time. You can save it
by selecting the text inside the box
and then clicking Insert and the arrow under the Text Box icon.
Choose "Save Selection to Text
Box Gallery."
Besides Word, text boxes appear
in Excel and PowerPoint 2007/10.
Neither program contains a text box
gallery, but each has the "Draw a
Text Box" tool, which gives you all
the functions that Word does, including rotation. You can also start
with a shape and include text by
right clicking and using the "Edit
Text" command.
Have a little fun. Create a few
text boxes in your next document,
spreadsheet or presentation.

(www.compukiss.com)
sandy(at)compukiss.com

If you walked into WalMart to
purchase a camera and the sales
person told you the camera you
were interested in was $300 and
then he offered it to the next person
in line for $200, you would probably be aggravated. If the clerk explained that your higher price was
based on the fact that he thought
you were a very interested buyer
who was ready to make a purchase,
while the other person was not a
serious buyer, you might be even
more outraged.
Yet, that is exactly what is happening with online shopping. Online retailers are using cookies to
track your moves. Although cookies are relatively harmless and unobtrusive, they show the retailer
exactly which items you have
looked at and how often you have
view them. Retailers can also use
click loggers, ad sites, and computergenerated statistics to track
your shopping. If you look at the
same item several days in a row,
the retailer might decide that you
will soon be ready to buy and raise
the price.
This happened to me recently,
NANCY DEMARTE is a regular
when looking for a bird feeder for
columnist (Office Talk), Sarasota
my husband for father's day. After
PCUG, Florida
several days looking at the item
(www.spcug. org
and mulling the purchase, the price
ndemarte @ Verizon.net).
This article appeared in the September of the bird feeder suddenly went
2012 issue, Sarasota PC Monitor, and from $42 to $51.
is distributed for reprint by user groups.
This is what is commonly re____________________________
ferred to as dynamic pricing which
is, in effect, changing the price of a
Dynamic Pricing
good based on what the retailer
thinks a buyer is willing to pay. If
Gives Different
you think about it, you realize that
Pricing to Different dynamic pricing has been around
for eons. In a street market hunPeople
dreds of years ago, a person who
Sandy Berger, CompuKISS
-continued on next page-
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was a better haggler may have paid
less for the same item as someone
who simply agreed to the first price
given.
Today's online dynamic pricing is
the practice of charging consumers
different amounts based, not on
their haggling ability, but on their
characteristics as consumers. Evidently, as long as this does not include discriminatory criteria, like
charging someone with blue eyes
more than someone with green
eyes, this is perfectly legal.
After all, airlines have been doing
it for years. They typically charge
more for flights that are popular
with business travelers and they
also have complex pricing schemes
to fill unused seats. This year the
St. Louis Cardinals introduced dynamic pricing for tickets to their
ball park. This allows the Cardinals
to charge more for "hot" games on
popular days. A recent look at ticket prices showed that an infield pavilion seat for a Saturday night
game was selling for $42. The
same seat on a weeknight might be
a little as $13.50. It was said that a
few years ago, Coca Cola did a test
with their vending machines that
charged more for soft drinks when
the outside temperature rose.
Dynamic pricing doesn't always
go against you. For instance, it
might be advantageous if you are
booking a last minute flight or
looking for a cheap ticket to the
Cardinal's game. When dealing
with dynamic pricing online, however, the instances that I saw in my
recent shopping have all been leading toward higher pricing. There is,
however, something that you can
do to counteract this when it goes
against you.
When they raised the price on my
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bird feeder, I decided to check out
the price of the feeder using another web browser that didn't have a
cookie identifying me. Sure
enough, the price was back to $42.
I was able to see the two different
prices at the same website side by
side when using two different web
browsers.
You can do the same thing, just
download a new web browser like
Firefox (www.firefox.com).
Chrome
(www.google.com/chrome), or
Opera (www.opera.com). These
are all free. Then visit the website
in question and look at their prices
without logging in or giving any
personal information. If you have
been using one of these alternative
browsers and want to use them for
a price comparison, you should
clear your cookies before you start
your price search. A setting for doing that is usually found in the
browser's Tools menu.
Dynamic pricing is not going
away anytime soon. It looks like it
will be a vital part of both offline
and online commerce for years to
come. So get used to it, but don't
get taken in by it.
____________________________

WHAT DOES “FIREWALL” MEAN?
By Leo otenboom
www.ask-leo.com
The bottom line is that a large
class of viruses and other types of
malware can be prevented simply
by using a good firewall. What’s a
firewall? Well, in your car it’s the
“wall” of metal behind the dashboard that sits between you and the
engine. Its purpose is to prevent
engine fires from roasting you and

your passengers.
A firewall for your computer is
much the same – its purpose is to
keep you from getting burned. A
firewall is at its core very simple: it
blocks or filters certain types of
network traffic from reaching
your computer. What do I mean by
“certain types”? There’s network
traffic you do want to reach your
computer: like the pages of web
sites you visit or the software you
might download. And then there’s
other traffic you might not want,
like malicious people or computers
trying to access your computer
remotely or viruses and worms
trying to infect your machine.
Firewalls can also usually be
configured; they can allow you to
say “this kind of connection from
the outside is OK”. A good example
is remote desktop. A firewall may
by default block any attempt to
connect via remote desktop. But
you can also configure the firewall
to allow that type of connection to
come through. Doing so you would
be able to access your computer
from another computer, be it across
the room or across the internet. But
even though you’ve allowed one
type of traffic – remote desktop –
other types of traffic like certain
types of viruses are still blocked.
Some firewalls will also monitor
outgoing traffic for suspicious
behavior. One characteristic of
many viruses is that once you’re
infected they attempt to establish
connections to other computers
in order to spread. Many software
firewalls will detect and either warn
you or simply prevent those
attempts. And that leads to a very
important distinction. There are two
types of firewalls:
hardware and software.
A hardware firewall is just that –
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a separate box that sits between you
and the internet that performs the
filtering function. Traffic that is
filtered out never even reaches your
computer. Even the least expensive
broadband router can perform the
function of a firewall quite nicely.
The downside for a hardware
device is that most will not filter
outgoing traffic.
A software firewall is a program
that runs on your computer. It
operates at the very lowest level, as
close to the network interface as
possible, and monitors all your
network traffic. While all network
traffic still reaches your machine,
the firewall prevents malicious
traffic from getting past it and on to
the operating system. The firewall
prevents your system from actually
noticing or doing anything with
malicious traffic.
The good news is that all versions
of Windows after XP have a software firewall built in, and all
versions after Windows XP SP2
have it turned on by default. In fact,
the security center will take steps –
perhaps even annoying you in the
process – to ensure that the firewall
is either turned on or that you’re
aware of the risks in not having it
turned on.
The bad news is that a firewall
can’t protect you from everything.
A firewall is focused on protecting
you from threats that arrive via
malicious connection attempts over
the internet. A firewall will not
protect you from things you invite
onto your machine yourself such as
email, attachments, software downloads and removable hard drives.
But even so, protecting from those
network threats is important. In
general, I recommend a hardware
firewall such as a broadband router
and leaving the Windows firewall
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turned off. However, regardless of
your approach, be it a router, be it
the Windows firewall, or be it some
other software or hardware
solution, some kind of firewall is
always a necessary part of keeping
your computer safe when connected
to the internet.
From the December 2012 issue of
Nybbles & Byter, newsletter of NEOPC
Club.

____________________________

Cybernews!
www.gary.stanley.net/
cyber_news.htm
By Gary Stanley
The top story this month is
Microsoft's new operating system,
Windows 8. It's been out now for
over a month and you can download it to your laptop or desktop
until January 26th for only $39.99.
That's the best price that's ever been
offered, but the big question is, do
you want to? Windows 8 was really
designed as a tablet operating
system, namely their new "Surface
Tablet." It will obviously compete
with Apple's iPad since tablets are
the wave of the immediate future.

If you purchase the new Surface
Tablet, or a new laptop you'll get
Windows 8. Some laptops will feature a touch screen and some will
not. In my opinion the sale of
laptops will go down because of the
popularity of tablets. I still own a
laptop but my iPad has all but replaced its use. I did however download Windows 8 on the laptop for
the experience and so I could give

seminars to computer clubs.
So, let's cut to the chase. Should
you upgrade your current desktop
or laptop to Windows 8? Experts
say no. If you're still running Windows XP Microsoft will support it
until April of 2014. If you're running Windows 7, stick with it as it
is a very stable, and reliable, and
the best selling system of all time.
As I've mentioned, Windows 8 was
designed for tablets and upgrading
your current system will only lead
to frustration because of the steep
learning curve and you really gain
very little except extra eye candy.
But wait, there's more! Windows
8 just released, everyone trying to
figure out how it works, and Microsoft is already talking about
"Windows Blue." It's the next operating system due next year! Read
more. goo.gl/2zQfZ
Rumor has it that Apple will release the iPhone 5S, the iPad5, and
the new iTV in the first half of
2013. Apple products are exciting
and innovative, but hard to keep up
with! Is this overkill? The story
from CNET. goo.gl/gDrU3
Staples announces in-store 3-D
printing. Soon you'll be able to print
your 3-D projects at your local
Staples store. So what is 3-D printing? The answer from CNN Tech.
goo.gl/wkxQg
Your email messages may not be
as private as you think! Most
people think that email is secure
and no one has access except you
and the recipient. We think it's this
secret thing that just goes from me
to you over a private pipeline. It
does not. It's like this giant letter
carrier's bag that we have access to
depending what kind of authority
you are or what kind of access you
have to someone's account. An
email is really like a postcard, open
--continued on next page--
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to many eyes, so keep this in mind!
Officers 2011-2012
Brian Cooley from CNET explains.
Elected Officers
goo.gl/UNOkq
President
Judi McDowell
(309) 314-1780
julee89@gmail.com
The holiday season is a time for
Vice President
Nancy Polios
(309) 755-4926
npolios@gmail.com
Secretary
Diana Wolf
(309) 797-5413
theqcs.sec@mchsi.com
cheers, but it's also a time for
Treasurer
Dave Tanner
(309) 764-6455
dl.tanner@mcshi.com
scams. It's sad but true that the bad
Directors at Large
Jim Buche
(309) 755-4893
jhbuche@mchsi.com
Marie Drexler
(309) 755-8138
drexlerrm@mchsi.com
guys are out to take advantage of
Ralph Drexler
(309) 755-8138
drexlerrm@mchsi.com
you. Be aware when you're shopTina Gean
(309) 373-1122
tina2121@yahoo.com
Melinda Missman
(309) 235-7579
mamissman@msn.com
ping. Don't put items that you've
Shari Peterson
(563) 468-1658
skp4joy@gmail.com
purchased out of your site for one
Susan Peterson
(309) 721-7048
felspaw@gmail.com
Karen Reynolds
(309) 797-6572
kajor31539@gmail.com
moment. Be aware when leaving
Emily Smith
(309) 794-9320
ginghis18@mchsi.com
the mall for suspicious looking
Director Past President Patty Lowry
(563) 332-8679
pattylowry@rocketmail.com
characters in the parking lot. If you
Director/SIG Leader
feel like you're being followed or
Beginners
Jim Kristan
(309) 755-8277
jmkris@gmail.com
there is someone lurking near your
Genealogy
Len Stevens
(563) 359-9672
judylenstevens@msn.com
car, turn around and return to the
Digital (coordinator)
Vicki Wassenhove
(309) 787-2239
wazz123@gmail.com
Internet
Ted
Huberts
(309)
792-9470
slowhand54@sbcglobal.net
store. This is especially true at
Office
Judi McDowell
(309) 314-1780
julee89@gmail.com
night.
QBits
Joe Durham
(309) 764-5570
joseph85_us@yahoo.com
Windows
Larry Stone
(309) 787-5574
lstone521@mchsi.com
Keep a close tab of your debit or
Appointed Officers
credit card purchases for odd
Membership Director
Susan Peterson
(309) 721-7048
felspaw@gmail.com
entries. While reviewing mine reProgram Director
Nancy Polios
(309) 755-4926
npolios@gmail.com
cently, I noticed a charge for 8 cents Public Relations Dir. Melinda Missman
(309) 235-7579
mamissman@msn.com
Publicity
Joe Durham
(309) 764-5570
joseph85_us@yahoo.com
and another one for $1.20 on the
Financial Committee
Mel VanderHoek
(563) 355-5085
vanderhoek@netexpress.net
same day. Then two days later a
APCUG Representative Patty Lowry
(563) 332-8679
plowryapcug@gmail.com
Membership Records
Susan Peterson
(309) 721-7048
felspaw@gmail.com
charge for $2.50 and $39.95. All
Web Master
Vicki Wassenhove
(309) 787-2239
wazz123@gmail.com
four charges were from the same
QBITS Newsletter
Joe Durham
(309) 764-5570
joseph85_us@yahoo.com
Patty Lowry
(563) 332-8679
pattylowry@rocketmail.com
company, an Internet Dot Com.
Mailing
Patty Lowry
(563) 332-8679
pattylowry@rocketmail.com
There was a notation that these
Resource Manager
Judi McDowell
(309) 314-1780
julee89@gmail.com
charges were an "International
Transaction." I went to the website
"Live Life with Passion, in a Conand it was shut down. I called the
stant State of Joy, and with an Attitelephone number and it didn't
tude of Gratitude!"
work. Of course my next step was a
trip to the bank where they initiated
an investigation and issued me a
new card with a different number.
MEMBERSHIP CORNER
You can't be too careful!
Membership dues are payable
Expose them to talent and they
July 1st each year and expire
will learn very young! Here's a two
the following June 30th.
year old that will amaze and enterIndividuals $30
tain you for a minute and forty two
Family
$40
seconds. This video has been
viewed almost 16 million times so
Payments can be made in
you know it's going to be good.
person at a meeting or
Here he goes! goo.gl/cv8YQ
mailed to the treasurer
David Tanner
3449 – 52nd Street
Moline, IL 61265
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SIG and Event Calendar
January 2013
Jan 7th – Monday

5:30 PM
7:00 PM

Beginners SIG
General Meeting

Jan 21st – Monday

5:30 PM

Jan 28th – Monday

309-755-8277

Genealogy SIG

EDC Jim Kristan
EDC Windows 8
with Larry Stone
EDC Len Stevens

7:30 PM

Internet SIG

EDC Ted Huberts

309-792-9470

5:30 PM

Digital Media SIG

EDC Vicki Wassenhove

309-787-2239

7:30 PM

Windows SIG

EDC Larry Stone

309-787-5574

563-359-9672

Location Key
EDC
BCL
ORC
OAK

Education Center of Butter wor th
Libr ar y of Butter wor th Hom e
Or chid Room of Butter wor th Hom e
Oak Room of Butter wor th Hom e

BUTTERWORTH HOME
8h St & 11th Ave Moline, IL

EDUCATION CENTER OF BUTTERWORTH
th
St & 12th Ave
Moline, IL
QBITS 7January
2013
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Quad Cities Computer Society
c/o Dave Tanner
3449 - 52nd St
Moline IL 61265

Moving? Send an
address change to:
felspaw@sbcglobal.net

This Month in QBITS ....
QCS Review:Staples!!
1
There Is More To SkyDrive Than You
Remember
3
Flash Memory Survival
4
VIPRE
4
Notes From the Beginner's SIG
5
Get Creative With Text Boxes
6
Dynamic Pricing Gives Different
9
Pricing to Different People
7
What Does “Firewall” Mean
8
Cyber News
9
QCS Membership Corner
10
QCS Officers 2012-2013
10
QCS Meeting Dates
11
QCS Map Directions
11
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Monday
January 7th, 2013
7:00 PM

Windows 8
presented by
Larry Stone
Windows SIG leader
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